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Getting Started Guide

Introduction to Getting Started Guide

Introduction

AppBuilder is a suite of tools used for developing, building, and testing software applications rapidly and efficiently. These tools include the
following:

Diagrammers for design activities
Tools to create the user interface and the high-level code itself
Debuggers for running an application in test mode
Wizards and tutorials to help you develop applications faster

This guide teaches you how to use many of these tools by building a sample application. Steps in this tutorial include building the application
hierarchy, creating the user interface, creating and preparing rules, and configuring for deployment and execution. It takes about three hours to
complete the tasks and create the project.

Intended Audience

This book is the right starting place if you are new to the AppBuilder environment. Some basic application development experience helps, but is
not required. You should be familiar with Microsoft Windows.
This guide is part of the AppBuilder documentation set. Other manuals contain more detailed procedures and more complete reference material.
See  for more information on the documentation package.AppBuilder Documentation

AppBuilder Documentation

The documentation package for AppBuilder includes a complete online help system and a set of the manuals in PDF format. The online help
system contains the same information that the manuals contain and can be accessed directly from the application, using the  menu or  .Help F1
The manuals in PDF format are available on the AppBuilder Installation CD and on the AppBuilder Customer Service web site (see Getting

 for detailed information).Additional Assistance

Documentation Conventions

This book uses the conventions described in the following table:

Conventions used in AppBuilder documentation

This Convention (Example) Specifies this type of information

Courier font DEV_GRT_LB Type the text (commands, code, etc.) exactly as it appears in
this guide.

Boldface OK Select the  ,  ,  , or  in the window.option function button selection

Menu choices Analysis > Verify Select the menu and option.

Key combination Alt + B Press the specified keys, at the same time.

Numbered procedure, in sequence 1. Type the name. 
2. Select  . OK
3. Close the window.

Perform the specified steps, in order.

Bulleted list
Apples 
Oranges 
Pears

Select from a list of valid options.



Numbered procedure or task list, with
options.

1. Open the file: 
a. Double-click the icon. 
b. Select  . The Open windowOpen
displays. 
2. Select the choice, then select OK
.

Perform a high-level task or procedure. The procedure might
include sub-tasks.

File names, variable names, and file
paths.

start <filename> Replace the italic text with a site-specific variable or option.

The following table summarizes the product documentation:

Documentation

Introductory Documents Workstation Operation Documents Reference Documents

Getting Started Guide Developing Applications Guide Development Tools Reference Guide

Installation Guide for
Windows

Debugging Applications Guide Scripting Tools Reference Guide

Communications Guide Deploying Applications Guide ObjectSpeak Reference Guide

IVP User Guide Reports Guide Rules Language Reference Guide

  Repository Administration Guide for Workgroup and Personal
Repositories

System Components Reference
Guide

  Multi-Language User Interface Guide Messages Reference Guide

    INI Settings Reference Guide

Descriptions of each guide are provided in the following sections.

Introductory Documents

Table 1-3 summarizes the documentation containing instructions about installing the product as well as other introductory information.

Introductory documents summary

Title Description

Getting Started
Guide

Explains the product documentation and provides a brief tutorial that builds a simple application to help you familiarize
yourself with the Construction Workbench interface. Steps in this tutorial include building the application hierarchy, creating
the user interface, and creating and preparing rules.

Installation
Guide for
Windows

Provides installation and configuration instructions for various parts of the AppBuilder product including workstation
Construction Workbench, workgroup repository, and workgroup servers on Windows platforms.

Communications
Guide

Provides the procedures for configuring the internal communications and setting up servers and machines from the
workstation.

IVP User Guide Provides a series of tests to verify that AppBuilder and the third-party applications it needs for your development
environment are set up and configured properly. IVP also serves as another sample application written with AppBuilder.

Workstation Operation Documents

The following table summarizes the documents that contain information about standard application operation. Some documents contain
information about interactions between workstations and servers or mainframes, but most relate to workstation operation.

Workstation operation documents summary

Title Description

Developing Applications Guide Provides the procedures for using AppBuilder to create applications. Includes information about project
development, rules, preparation, and deployment. Describes both stand-alone and distributed applications in
multiple environments.

Debugging Applications Guide Provides the procedures for debugging and troubleshooting the application.



Deploying Applications Guide Provides the procedures for configuring, packaging, deploying, and executing applications on distributed
machines in the network. Includes steps for configuring the execution environments and details about web
archive deployment and remote rule execution.

Reports Guide Provides the procedures for creating reports on the workstation with Report Painter and seeing the results on
the mainframe with Enterprise Report Writer or on web servers with Java Report Writer.

Repository Administration
Guide for Workgroup and
Personal Repositories

Provides detailed information about the use of Windows-based development workstation repositories,
including configuration, migration, and systems administration.

Multi-Language User Interface
Guide

Explains the multi-language user interface and how to use it to develop applications with language-dependent
user interfaces that can be targeted to different language environments.

Reference Documents

The following table summarizes the documents that contain general AppBuilder product reference information.

Reference documents summary

Title Description

Development
Tools
Reference
Guide

Provides a reference for the many tools available in the Construction Workbench for developing applications. Includes a
summary of the toolbars, the Hierarchy window tabs, the Window Painter, the Menu Editor, the Rule Painter, and other tools for
planning and developing applications.

Scripting
Tools
Reference
Guide

Describes the TurboScripter capabilities and offers a complete reference for TurboCycler object generation and task
automation capabilities. Includes a description of the Developer Kit's open architecture for automatically generating repository
objects and the ActiveX object that provides a scriptable repository interface.

ObjectSpeak
Reference
Guide

Lists the object dot notation that is available for use with Rules Language rules in application development. This version with
Java support is called ObjectSpeak.

Rules
Language
Reference
Guide

Describes the AppBuilder Rules Language used to specify the processing logic of the application and how the entities that
comprise an application interact.

System
Components
Reference
Guide

Lists the available system components that can be included in applications development.

Messages
Reference
Guide

Lists the preparation time and runtime information and error messages.

INI Settings
Reference
Guide

Lists the settings in the initialization files that affect the behavior and operation of AppBuilder.

Using the Online Help

Use the online help on the workstation to view detailed information about working in the AppBuilder environment. From the desktop, select Start >
. To access the online help while using the application, press  or select All Programs > AppBuilder > Documentation > AppBuilder32.chm F1 Help >

 from the Construction Workbench menu bar.Contents
The online help window includes three panes. The top pane contains toolbar controls for the window. The navigation pane provides multiple
means to access the contents of the help. The content pane provides the topics themselves.

Toolbar
Navigation Pane
Content Pane

Online help example



 

Toolbar

AppBuilder Help Toolbar

The toolbar buttons on the online help window provide the following options:

Help toolbar buttons

Button Function

Back Moves backward in the sequence of topics that have been displayed in the window.

Forward Moves forward in the sequence of topics that have already been displayed in the window.

Home The default screen for the help system.

Print Prints either the designated topic or that topic and all subtopics to a specified printer.

Options Provides multiple options for the window display, including hiding the navigation tab, changing browser options, and others.

Navigation Pane

Use the Navigation Pane in any of several ways to find the information you need more quickly than by paging through AppBuilder help.



Navigation Pane

You can use the navigation pane in any of the following ways:

Using the Contents Tab
Using the Index Tab
Using the Search Tab
Using the Favorites Tab

Using the Contents Tab

Click the  tab to display a table of contents for all of the guides, including all of their chapters and sections. These contents contain allContents
major topics. The contents tab normally does not display pages with examples as well as pages with detailed lists.

Contents tab



Double-click a book icon.  This opens the book  and displays the topics beneath it. Continue to double-click to navigate to the topic you

want to view. Click the topic icon  to display the selected help text. The contents of the topic display in the content pane. To collapse or expand
a topic, click the plus or minus signs or double-click an icon.

Using the Index Tab

Click the  tab to display a list of indexed terms included in the online help. The index includes topics from the entire documentation set.Index

Index tab

Select an item or topic of interest and click  to view the related help text.Display
If the index term appears in more than one topic, the system displays a list of the books and links to topics. Select a topic by clicking the topic title.
An example is shown in the following figure:



Multiple topics shown in content pane

Using the Search Tab

Click the  tab to search the online help for information related to a key word or words. Type any key word or words and click  .Search Display

Search tab

The results are listed by topic title. Double-click any search result to display the selected topic in the content pane.
Some important items to consider when searching:

The search engine does not provide any feedback as a word is typed. No results are displayed until the  button is clicked.List Topics
The search engine allows for boolean searches. Click the

 button to the right of the search field to search on a combination of terms:



  
Use a boolean search to narrow the search.

If you type multiple search words, the help system searches for topics that contain  of the search words.all
The help system "remembers" your previous searches. To recall previous searches, select the  check box.Search previous results
Other options allow for matching similar words and searching only topic titles.

Using the Favorites Tab

The Favorites tab makes it easy to bookmark a particular topic and recall it quickly. Add topics using the  button.Add

  

Content Pane

The Content pane displays the AppBuilder help content. From this pane you can read the content, follow links to related or referenced topics, or
move within the help content by going to the previous or next topic.

Sample Help Text pane



Use the   and   buttons to navigate throughout the help text. These buttons in the online help system move sequentiallyPrevious Next
through the topics in the manual. They are separate and different from the toolbar's Forward and Back buttons.
Some text and graphics contain hyperlinks in blue text. Click the link to display the associated information.

Using the Printable Manuals

The documentation set also contains manuals in a format which is easily printable---PDF format (portable document format files created using
Adobe? Acrobat?). You can read and print the documentation using Adobe Acrobat. You can access the printable manuals from the AppBuilder
Installation CD or you can search on the AppBuilder Customer Service web site (see also  for further information) Getting Additional Assistance .
See  for a summary of the books.AppBuilder Documentation
In the Printable Documents window, select a book from the list. This opens the book in Adobe Acrobat format. Page through the documentation or
use the table of contents on the left for easy navigation. You can print the entire document or specific pages. For more information about using
Adobe Acrobat, refer to the Adobe Acrobat documentation.

Adobe Acrobat is required to search the master index and display and print documents in PDF format. You can download a free
copy of Acrobat Reader from the Internet at http://www.adobe.com

The printable manuals include the documentation set for AppBuilder. The online and searchable version of these guides are also available by
pressing the  menu item or pressing  from the AppBuilder Construction Workbench.Help F1

Searching the Printable Books

To search the entire set of AppBuilder books for specific information, open the printable book and click the Search button on the toolbar  .
Use the  button to perform a full text search of all the books.Search
In the Search dialog box ( ), type the word or words you want to search. If they only occur once in the set,Example search of the printable books
the exact book and page are opened for viewing. If they occur more than once, a list of the books is displayed in a Search Results dialog. From
that list, select the book for which you want to see the results. You can come back to this list of books at any time by clicking the Search Results

button in the toolbar  .

Example search of the printable books

http://www.adobe.com


You can use this search feature from any of the books.

Using the Tip of the Day

AppBuilder comes with tips that you can display about optimal use of the tools. When you first run the product, the tip of the day dialog is
automatically displayed, as shown in . You can also display the tips by selecting  from theTip of the Day example Help > Tip of the Day
Construction Workbench menu bar. Select the check box if you want the Tip of the Day to show at each startup. Click  repeatedly to lookNext Tip
at several of the tips sequentially.

Tip of the Day example



1.  

Finding Version Information

To find out which version of AppBuilder components, programs, or fixes you have installed on a machine, select from the Construction Workbench
Help > About Magic Software AppBuilder > AppBuilder Info.

Getting Additional Assistance

After you have reviewed the product documentation, either  or , and you still have a question orUsing the Online Help Using the Printable Manuals
require some assistance, check with your system administrator for problems relating to the installation or network operation of the product.
If you still need assistance or for the latest documentation and updates about the product, contact AppBuilder Customer Support using the
information given in this section.
Contact AppBuilder Customer Support:

Internet: http://support.appbuilder.com
E-mail: AppBuilderSupport@magicsoftware.com

Starting the Integrated Environment
AppBuilder provides a robust, integrated toolset to design, implement, and maintain high volume, multi-platform, distributed applications. The first
step is to start the environment on your workstation, which involves the following:

Connecting to a Repository
Starting AppBuilder
Understanding the Construction Workbench
Planning the Sample Application

Connecting to a Repository

When starting AppBuilder, you must access the repository that you installed when you installed AppBuilder (refer to Installation Guide for
 ) to store your project and options. A repository is an intelligent, relational database that holds software application objects, the methodsWindows

and facilities used to access the objects and the relationships among the objects.
There are three types of repositories:

Personal (workstation)
Workgroup (department server)
Enterprise (mainframe)

For more information on the installation options for repositories, see the  . For details about these repositories, howInstallation Guide for Windows
to install them, how to connect to them, and how to maintain them, refer to the Repository Administration Guide for Workgroup and Personal

 .Repositories
This exercise is specific to building an application using a Personal repository.

From the Windows desktop, click   then select .Start , Programs > AppBuilder > Construction Workbench
The Connect to Repository dialog displays, as shown below:

http://support.appbuilder.com


1.  

2.  
3.  

4.  

Connect to Repository dialog

From the  dropdown list, select the repository to access.Repository
Type your  and  and click  .User name Password Connect
The AppBuilder Construction Workbench displays.  identifies the parts of the workbench. The systemConstruction Workbench window
also displays the Tip of the Day.
Click  to close the Tip of the Day window and begin using AppBuilder.Close

If the Construction Workbench takes a long time to load or the repository takes a long time to find, you might have the ODBC
trace set on your workstation. If the ODBC trace is set, a lot of logging is being done when accessing the underlying repository
database. Once the tracing is stopped and this setting is applied, the connection time returns to normal. In Control Panel >

 , set  and click  .Administrative Tool > Data Sources (ODBC) > Tracing Stop Tracing Now OK

Starting AppBuilder

To start AppBuilder from the Start menu, select AppBuilder from the Start menu. A submenu displays with a menu of choices:

Configuration
Documentation
Execution Clients
Repository
Construction Workbench

You can perform many AppBuilder configuration tasks by selecting the Configuration, Execution Clients, and Repository menu items. However,
you will perform most of your development in AppBuilder using the Construction Workbench.

Understanding the Construction Workbench

The Construction Workbench (see ) contains all the tools needed to build the application hierarchy. The mainConstruction Workbench window
parts of the Construction Workbench are:

Menu bar ? Provides access to AppBuilder commands
Toolbar ? Includes a collection of buttons that provide quick access to tools, commands, and objects
Hierarchy window ? Contains tabs to build project hierarchy and deployment configurations and provides an area to store and query
objects from the repository and display the parents of an object
Status window ? Contains tabs to monitor a process such as preparation, analysis, or debugging
Status bar ? Displays the current preparation mode, help for each tool, and other information
Tool window ? Provides a work area for the specific AppBuilder tools (for example, Window Painter or Rule Painter)
Object Property window - Contains editable fields with informations about the object preferences.

Construction Workbench window 



The AppBuilder Construction Workbench has the following features to help you work more efficiently:

The system displays the name of any button or icon over which you move the cursor.
Each part of the workbench (for example, Hierarchy or Status window) can be resized or converted into a floating window and positioned
anywhere on the Windows desktop.
The system only displays menus, toolbars, and options that are valid at any given time, based on the currently selected object.
To customize the interface and tools, select  from the Construction Workbench menu. Each tool within theTools > Workbench Options
Construction Workbench (for example, Hierarchy window or preparation tool) contains a tab with tool-specific options. These are
explained more fully in the  .Development Tools Reference Guide

Planning the Sample Application

This guide takes you through the process of building an application that echoes input data back to you in an output field (See Hello World
). By creating this sample application, you can learn to use the main AppBuilder tools to build the application hierarchy, create the userapplication

interface, create and prepare rules, and configure the application for deployment and execution.

Hello World application



1.  
2.  
3.  

The sample application is designed as a standalone Java client application that can run locally on your machine. Creating the Configuration
 discusses other possible configuration and deployment scenarios.Hierarchy

You must have the Java runtime compiler installed on your workstation PC to create the sample application. Consult your
system administrator for more information.

When building the sample application,  your work to the repository often. Select  from the Construction Workbench menu,commit File > Commit

click the  button  in the toolbar or press  on your keyboard to save the sample application. If the  button is dimmed,Commit Ctrl+M Commit
the repository already contains the most recent changes.

Defining the Overall Application Hierarchy
The hierarchy diagram describes the structure or part of the structure of an application. This structure specifies how the application executes. Use
the  tab of the Hierarchy window to build the objects, such as rules and windows, in the application hierarchy and their relationships. TheProject
tasks in defining the hierarchy include the following:

Using the Hierarchy Toolbars
Creating the Project
Adding a Function
Adding a Process
Adding a Rule
Adding a Window
Adding Views
Adding Fields

Using the Hierarchy Toolbars

AppBuilder contains two Hierarchy toolbars for manipulating objects in the project hierarchy.

Open the Construction Workbench and log on to the Personal Repository. See .Connecting to a Repository
If the Hierarchy window is not displayed, select  .View > Hierarchy
To add the hierarchy toolbars, select  >  and  from the ConstructionView > Toolbars Hierarchy - Objects Hierarchy - Operations
Workbench.

When you select each toolbar, it is displayed in the Construction Workbench.

Hierarchy - Objects toolbar (used with Hierarchy diagrammer)



1.  

Hierarchy - Operations toolbar

In addition to using the toolbar, you can also use one of the following methods to work with objects:

Right-click an object in the Hierarchy window and select a function from the pop-up menu.
Select an object in the Hierarchy window and select  or  from the Construction Workbench.Insert Edit

Creating the Project

In an AppBuilder application, the Project object contains the business function (see ) and associated configurations of theAdding a Function
application. The project is the highest level of the application hierarchy. For this sample application, we create the project illustrated in Planning

.the Sample Application

Select  from the Construction Workbench menu. The Create New Project window displays, as shown in File > New Project Create New
.Project window

Create New Project window



1.  

2.  

3.  

Configure the following options for the sample application:

Field What to enter Description

Project
Name

HELLO_WORLD Name of the project. (For most of the objects you create, the name can be only 30 characters long,
upper case, case insensitive, with no special characters or spaces; only underscore is allowed. The
OO objects' names are mixed case, case sensitive, no special characters or spaces, underscore
allowed. The Insert window does not allow any mistake, disabling the Insert button when you type a
wrong character)

Standalone
application

Java application AppBuilder prepares the application and rules to execute in a Java environment.

Database
type

N/A The sample application runs locally on your PC and does not require a connection to a database or
server so this setting does not matter. Leave the other database fields (  , Database name User name
,  ) blank.Password and URL

Use
SQLJProfile

Customizer

N/A This utility augments the profile with DB2-specific information for use at run time.The SQLJ translator
performs analysis on the SQLJ source file by checking for incorrect SQLJ syntax. For the sample
application, this box does not need to be checked.

Include
mainframe
rules?

N/A Any rules that would run on a mainframe would be prepared locally on your PC if this were checked.
When not checked, it only checks syntax and does not prepare those rules. Since the sample
contains none, the setting does not matter.

If you use a Workgroup or Enterprise repository, add a unique identifier to the end of each object you create for the
sample application (for example,  ). This eliminates potential problems if other developers also attempt toProject Name
create the sample application.

Click  .OK

The Hierarchy window displays, as in , showing the new project as the top of the application hierarchy on the Hierarchy window with function
 tab.  displays in the status bar of the Construction Workbench.Project Standalone



1.  

2.  

If the system displays a  message contact your system administrator or repository administrator toSecurity Validation Failed
gain the necessary permissions.

Hierarchy window with function

Adding a Function

A function represents the highest-level business function ? the purpose of the application. At execution time, the function may appear as a
desktop icon or menu option that the end-user can access. Functions contain groups of processes that subdivide the application.

In this sample application, the function accepts user input, and then the input echoes back to the user.

Click the  function on the  tab of the Hierarchy window. The Object  window displays the properties, asHELLO_WORLD Project Property
shown in the following figure.

You can configure the Construction Workbench options to use double-click to show the properties of an object from the
Hierarchy window.

Type  in the  field and press Enter.Hello World Application Menu description

Object Property dialog



2.  

1.  

2.  

Adding a Process

A process represents a logical unit of work or activity that can manipulate the data within the application. In an AppBuilder application, processes
appear as options on pull-down menus.

For the sample application, we create a process to allow user input and system output.

Select the  function and click the  button  HELLO_WORLD Process in the Hierarchy Objects toolbar.
You can also add a process by:

Right-clicking the  function and selecting  from the pop-up menu.HELLO_WORLD Insert Child > Process
Selecting the  function and selecting  from the Construction Workbench menu.HELLO_WORLD Insert Child > Process
Clicking the  buttonInsert Child

 in the Hierarchy Operations toolbar and selecting  from the pop-up menu.Process
In the Insert Process dialog, type  in the  field and click  .HELLO_CLIENT_PROC Name Insert

The Hierarchy Diagrammer shows the new process as a child of the  function, as shown in the following figure:HELLO_WORLD

Hierarchy window with process



1.  

2.  

3.  

Adding a Rule

In an AppBuilder application, rules are programming statements that define the logic of the application (that is, how the application works). At
execution time, each rule performs a unique action.
This sample application requires two rules: one rule (  ) to handle the user interface (input and output) and one rule (  ) to handle theclient server
business logic. In this section, we add the rules to the hierarchy. In  we add the actual rule code.Creating Rules

Select the  process and click the  button  in the hierarchy toolbar.HELLO_CLIENT_PROC Rule
You can also add a rule by:

Right-clicking the  process and selecting  from the pop-up menu.HELLO_CLIENT_PROC Insert Child > Rule
Selecting the  process and selecting  from the Construction Workbench menu.HELLO_CLIENT_PROC Insert Child > Rule
Clicking the  buttonInsert Child

 in the Hierarchy Operations toolbar and selecting  from the pop-up menu.Rule
In the Insert Rule dialog, type  in the  field and click  . This rule accepts the user input and displays theHELLO_CLIENT Name Insert
output.
The Hierarchy Diagrammer now shows the new rule as a child of the process.
Add a second rule as a child of the  rule. Name this rule  . This rule copies the user input to the output.HELLO_CLIENT HELLO_SERVER

Your hierarchy diagram should look like the one shown in the following figure:

Hierarchy window with rules



1.  

2.  

Adding a Window

Windows accept input or display data to the end user. In an AppBuilder application, windows are linked to  that contain the actual dataviews
elements, such as fields, for the window.
For our sample application, we need to create a window to handle the end-user input and the system output. In this procedure, we add the
window to the hierarchy. In  we create the actual window graphical user interface (GUI).Creating the User Interface

Select the  rule and click the  button  in the hierarchy toolbar.HELLO_CLIENT Window
You can also add a window by:

Right-clicking the  rule and selecting  from the pop-up menu.HELLO_CLIENT Insert Child > Window
Selecting the  rule and selecting  from the Construction Workbench menu.HELLO_CLIENT Insert Child > Window
Clicking the  buttonInsert Child

 in the Hierarchy Operations toolbar and selecting  from the pop-up menu.Window
In the Insert Window dialog, type  in the  field and click  .HELLO_WIN Name Insert

The Hierarchy Diagrammer now shows the window as a child of the  rule and a sibling of the  rule, as shown inHELLO_CLIENT HELLO_SERVER
the following figure:

Hierarchy window with window



1.  

2.  

3.  

Adding Views

Views are structures that contain data elements, such as fields or other views, and define the data structure of the application. Views attached to
a window are called  . These views define the data displayed to a user, data entered by a user, and data stored by thewindow message views
system.
For our sample application, we need to create views to handle input by the user, output to the user, and data displayed on a window. To create
views, complete the following steps:

Select the  rule and click the  buttonHELLO_SERVER View

 in the hierarchy toolbar.
You can also add a view by:

Right-clicking the  rule and selecting  from the pop-up menu.HELLO_SERVER Insert Child > View
Selecting the  rule and selecting  from the Construction Workbench menu.HELLO_SERVER Insert Child > View
Clicking the  buttonInsert Child

 in the Hierarchy Operations toolbar and selecting  from the pop-up menu.View
In the Insert View dialog, type  in the  field and click  .HELLO_SERVER_IV Name Insert

The  indicates that this is an  view. We recommend that you use a standard naming convention to easily identifyIV input
the objects in your applications and repositories.

The Hierarchy Diagrammer now shows the new view as a child of the rule.

Double-click the newly created view. The  panel displays the information, as shown in the following figure:Object Property

Object Property - Relationship [OWNS_VIEW] dialog  



3.  

4.  

5.  

Click the Relationship[OWNS_VIEW]section to display the option fields, select  from the   drop-down list and press Input View View usage
 . This specifies how the parent rule uses the data in this view.Enter

Repeat steps 1 - 4. Replace steps  and  with the following additional views:2. 4.
A view as a child of the  rule. Name this view  . Set the  to  . ThisHELLO_SERVER HELLO_SERVER_OV View usage Output View
view handles the output view.
A view as a child of the  window. Name this view  Set the  to  . ThisHELLO_WIN HELLO_WIN_V. View usage Input & Output View
view handles the end-user window.

Your hierarchy diagram now looks like the one shown in .Hierarchy window with views

Hierarchy window with views
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2.  

3.  

Adding Fields

Fields are the smallest unit of data in an AppBuilder application. Fields can record the input/output definition of objects or contain information
about part of a file, such as a column in a database table. An edit field object defines a field in which the end user can either enter and change
data, or view read-only data.
For the sample application, we need to create input and output fields for each view. To create input and output fields for each view, complete the
following steps:

Select the  view and click the  button  in the hierarchy toolbar.HELLO_SERVER_IV Field
You can also add a field by:

Right-clicking the  view and selecting  from the pop-up menu.HELLO_SERVER_IV Insert Child > Field
Selecting the  view and selecting  from the Construction Workbench menu.HELLO_SERVER_IV Insert Child > Field
Clicking the  buttonInsert Child

 in the Hierarchy Operations toolbar and selecting  from the pop-up menu.Field
In the Insert Field dialog, type  in the  field and click  . This field handles the end-user input.INPUT_MESSAGE Name Insert
The Hierarchy Diagrammer now shows the new field as a child of the view.
Double-click the  field in the Hierarchy Diagram window and the Object Property window displays the information, asINPUT_MESSAGE
shown in .Object Property - General [Field] dialog

You can configure the Construction Workbench options to use double-click to show the properties of an object from the
Hierarchy window. Select  from the Construction Workbench menu. Use the Tools > Workbench Options Double-click

 field on the  tab to specify the default double-click action.actions Hierarchy

Object Property - General [Field] dialog
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2.  

3.  
a.  

b.  
c.  
d.  

Enter or change the following fields:
Screen literal-long : Enter Input Message
Field Format : Character
Field Length : 30
Press Enter after every input text.

Repeat steps 1 - 4 to add the output field as a child of the  view. Name this field  . ThisHELLO_SERVER_OV OUTPUT_MESSAGE
handles the output view. For step 4, enter or change the following fields and press Enter:

Field Format : Character
Field Length : 256

Because these fields also are included on the end-user window, you must add the fields to the  view.HELLO_WIN_V
Select both the  and  fields.INPUT_MESSAGE OUTPUT_MESSAGE

To select multiple objects, press  while clicking the object names.Ctrl

Select  from the Construction Workbench menu. You can also right-click and select  from the pop-up menu.Edit > Copy Copy
Select the  view.HELLO_WIN_V
Select  from the Construction Workbench menu. You can also right-click and select  from the pop-up menu.Edit > Paste Paste
You can also copy fields (and other objects) by pressing  while dragging the fields to the view.Ctrl
The system creates a copy of both fields as children of the  view.HELLO_WIN_V

The hierarchy diagram should look like the one shown in the following figure.

Completed hierarchy diagram



To save the hierarchy, commit all changes to the repository. Select  from the Construction Workbench menu.File > Commit

You can also commit changes by clicking the  button  in the toolbar or by pressing Ctrl+M on your keyboard.Commit
Now that the application hierarchy has been built, we can create the user interface. Continue with .Creating the User Interface

Creating the User Interface

You use the Window Painter to create the end-user interface for each window in an AppBuilder application. You can create objects within the
window (for example, text fields, list boxes, or push buttons) to allow the end-user to view or modify the data and control the application. Window
Painter contains extensive tools for customizing the size, color, and other attributes of each object.
The Hello World sample application contains a single window named  . In this section we create the user interface for the application.HELLO_WIN
The tasks in creating the window include:

Using Window Painter
Creating a Window
Adding an Edit Field
Adding Static Text
Adding Buttons

Depending on your execution environment, you can also use a third-party HTML editor to generate HTML interfaces. The 
 contains detailed information about creating, importing, and exporting HTML windows.Development Tools Reference Guide

The  includes a chapter about Window Painter and how to use it to construct a GUI.Development Tools Reference Guide

Using Window Painter

The Window Painter toolbar provides a method for quickly adding interface objects to the window.
To open Window Painter, double-click the window HELLO_WIN in the Hierarchy window.
Select  > Window - Objects if not already selected from the  menu.View > Toolbars Construction Workbench

Window Objects toolbar



1.  

a.  
b.  

2.  

You can use the Window Layout toolbar (Figure 4-2) to quickly and easily align objects in the window. Select one or more objects, then click the
appropriate button in the Window Layout toolbar.

Window Layout toolbar

In addition to using the toolbar, you can also manipulate window objects by selecting the object and then selecting  from the ConstructionLayout
Workbench menu.

Creating a Window

Earlier, you created the window object in the application hierarchy. Use the following procedure to create a graphical form of the HELLO_WIN
window object:

Right-click the  window on the  tab of the Hierarchy and select .HELLO_WIN Project Open Window

You can configure the Construction Workbench options to use double-click to show the properties of an object from the
Hierarchy window. Select  from the Construction Workbench menu. Use the Tools > Workbench Options Double-click

 field on the  tab to specify the default double-click action.actions Hierarchy

The Window Painter displays, showing a blank window. Since the sample application only contains two fields, it might be necessary to
resize the window by doing the following:

Click the window.
Click and drag one of the window handles to resize the window, as needed.

If the Properties dialog box is not visible (as shown in ), right-click the HELLO_WIN blank window fromHELLO_WIN Window properties
the tool panel and select  (or double-click the tool window and the Properties box displays). Use the Properties window toProperties
control the display attributes for the window.

HELLO_WIN Window properties
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3.  In the  field, type  and press  .Text Hello World Application Enter
At runtime, this text displays in the window title bar.
<Locked> indicates the window is locked in the repository by the current session. * indicates the window has been modified. When you
commit your session to the repository, these markers will no longer display.

Hello World Application * <Locked> window
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3.  

Adding an Edit Field

Edit fields create input and output areas in a window. In an AppBuilder application, an edit field can be populated by typing in data at runtime or by
mapping data from a rule.

Hello World Application window with fields

For our sample application, we need to add an input and an output field to the Hello World Application window.

Click the  button  in the window object toolbar and move the cursor to the Window Painter window.Edit Field
The cursor changes to a plus (  ).+
In the Window Painter window, click the  window to add the field to the window. The system places a blank editHello World Application
field in the window.

To move the field, click and drag the field.
To resize the field, click and drag one of the window handles.

Select the newly created field. In the Field Properties window select  from the  drop-down list (as shown in INPUT_MESSAGE Link Field
) and press  . This links the display field to the  field in the hierarchy.Properties window Enter INPUT_MESSAGE

If the Properties window is not visible, right-click the HELLO_WIN window in the Tool window and select  , orProperties
double-click the new field to display the window.

Field Properties window
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4.  

5.  

6.  

Create a mutli-line edit field to handle the application output. Click the  buttonMultiline Edit Field

 in the window object toolbar and move the cursor to the Window Painter window.
The cursor changes to a plus (  ).+
Repeat step  to add the output field.2.

Link this field to  from the Link drop list and press Enter.OUTPUT_MESSAGE
Change the  field to  .Editable True
Change the  field to  .Word Wrap True

To align the fields, select both fields and then select  t from the Construction Workbench menu or click the Layout > Align > Lef Align Left

button  in the Window Layout toolbar.

To select multiple fields, press  while clicking the fields.Ctrl

Your window should look like the one shown in .Hello World Application window with fields
In addition to adding fields by creating them with Window Painter, you can also add fields to a window by dragging them from the hierarchy on the

 tab of the Hierarchy window into the Window Painter window.Project
The system adds the field (and a text label, if the  field of the Properties window of a field is defined as shown in Screen Literal Long Object

) to the window. The static text (text label) is not grouped with the field; if you move the field, you must move theProperty - General [Field] dialog
text separately.

Adding Static Text

Static text is a text label placed anywhere in a window. These labels are for display only and do not link to a repository field. End users cannot
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2.  

3.  

change static text.

Hello World Application window with fields and labels

For the sample application, we must add text labels to identify the two fields in the  window.Hello World Application

If you add fields to the window by dragging them from the hierarchy, the system automatically includes a text label if it is
identified in the properties of the field. You can edit or change this label, as needed.

Click the  button  in the window object toolbar and move the cursor to the Window Painter window. The cursor changesStatic Text
to a plus ( ).+
In the Window Painter window, click on the  window object to add the text to the window. The system places aHello World Application
blank text box in the window.

To move the text box, click and drag the text box.
To resize the text box, click and drag one of the text box handles.

In the  field of the Properties window (as shown in ) remove the word "text" and type  andText Field Property window Enter Input Message:
press  . This is the text label that displays for the window input field (HELLO_WORLD_INPUT.)Enter

If the Properties window is not visible, right-click the text box and select  .Properties

Field Property window
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4.  

5.  

Repeat steps 1 - 3, and for step 3, add the following static text for the window output field:
Output Message from Server:
To align the fields, select both fields then select  t from the Construction Workbench menu.Layout > Align > Lef

You can also align objects by selecting the objects then clicking the  button  in the Window Layout toolbar.Align Left

To select multiple fields, press  while clicking the fields.Ctrl

Your window should look like the one shown in .Hello World Application window with fields and labels

Adding Buttons

A push button allows the end-user to trigger an event. End-users can select buttons either by mouse click or an accelerator key. In an AppBuilder
application, push buttons are not connected to a specific repository object - so clicking one or using an accelerator key sends an event to a rule.

Completed Hello World Application window
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2.  

3.  

4.  

For the sample application, we need two buttons: one to send the end-user input to the server and one to close the Hello World Application
window. To create these buttons, complete the following steps:

Click the  button  in the Window Painter toolbar and move the cursor to the Window Painter window. The cursorPush Button
changes to a plus ( ).+
In the Window Painter window, click the Hello World Application window to add the button to the window.
The systems places a blank button named  in the window.Push

To move the button, click and drag the button.
To resize the button, click and drag one of the button handles.

Use the button Properties window ( ) to specify the attributes for this button.Button Properties window

Button Properties

Field What to enter Description

HpsID CallServerButton The unique name of this button. AppBuilder uses this ID to reference this button in other views and rules.

Text Call &Server The text that displays on the button. The ampersand (  ) identifies the keyboard shortcut for this button&
(that is,  for this button).Alt + S

If the Properties window is not visible, right-click the button and select  .Properties

Button Properties window

Repeat steps 1 - 3 to add a second button to close the windows. Use the following properties for this button in step 3:
HpsID = CloseButton
Text = &Close

Your window should look like the one shown in .Completed Hello World Application window
To preview how the window displays, open the window and select  from the Construction Workbench menu or clickLayout > Preview in runtime
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1.  

the  button  in the Window Layout toolbar.Preview
Be sure that you save changes by .Committing Changes

Committing Changes

To save the window and commit all changes to the repository, do one of the following:

Select  from the Construction Workbench menu.File > Commit
Click the  buttonCommit

 in the toolbar or press Ctrl+M on your keyboard.
Now that the user interface is complete, we must write the rules to control the application. Continue with .Creating Rules

Creating Rules

To create and edit the rules that control how the application executes, use the Rule Painter in the Construction Workbench. Creating a rule is
similar to creating a procedure in a computer language, such as C or Cobol. The Rule Painter includes several tools for quickly building and
testing rule statements. The tasks in creating rules include the following:

Using Rule Painter
Adding a Client Rule
Adding a Server Rule
Verifying Rules

For this sample application, you have already created in the Hierarchy Diagram the rule statements for the two rules, HELLO_CLIENT and
HELLO_SERVER, as shown in . Now you will create the rules (code).Completed hierarchy diagram

Using Rule Painter

Rule Painter is basically a text editor that lets you enter, change, delete, and move rule statements within the Rule window. The functionality is
similar to context-based source editors.
The Text Editor - Tools toolbar provides a method for quickly adding statements to the rule.

To open Rule Painter, double-click HELLO_SERVER in the Hierarchy window.
Select  > Text Editor - Tools if not already selected from the  menu.View > Toolbars Construction Workbench

Text Editor - Tools toolbar

In addition to using the toolbar, you can also use one of the following methods to add items to rules:

Right-click in the Rule Painter window and select an item from the pop-up menu.
Click the Rule Painter window and select  from the Construction Workbench menu.Tools

Adding a Client Rule

For our sample application, the client rule requires two procedures: one to handle the  button, and one to handle the  button.Call Server Close

In this sample application (or Hello World application), when you click  , the system calls the  rule.Call Server HELLO_SERVER
When you click  , the system closes the Hello World Application window.Close

To add a client rule, follow the steps:
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2.  
a.  

b.  
c.  

3.  

4.  

5.  

Right-click the  rule on the  tab of the Hierarchy window and select . Rule Painter displays a blankHELLO_CLIENT Project Open Rule
text window.

You can configure the Construction Workbench options to use double-click to show the properties of an object from the
Hierarchy window. Select  from the Construction Workbench menu. Use the Tools > Workbench Options Double-click

 field on the  tab to specify the default double-click action.actions Hierarchy

Add a comment line to identify this rule. Although comments are not required, it is good programming practice.
Type  and press  . In the AppBuilder Rules Language, this signifies the beginning of a comment. As you type the*> Enter
comment, the system automatically colors the comments green.
Type  and press  .Rule: HELLO_CLIENT Enter
Type  and press  to signify the end of comment. The text displays green. Make sure that the > and < are facing the right<* Enter
way.

Type the following procedure (Call Server) in the rule window:

proc CallServerButtonClick  Click object CallServerButtonfor
(e object type ClickEvent)
map INPUT_MESSAGE of HELLO_WIN_V to INPUT_MESSAGE
of HELLO_SERVER_IV
use rule HELLO_SERVER
map OUTPUT_MESSAGE of HELLO_SERVER_OV to OUTPUT_MESSAGE
of HELLO_WIN_V
endproc

As you type the rule, the system automatically colors any reserved words (for example, proc or map) blue.

To add the second procedure (Close), type the following procedure in the rule window:

proc CloseButtonClick  Click object CloseButtonfor
(e object type ClickEvent)
HELLO_WIN.Terminate
endproc

Your window should look like the one shown in .HELLO_CLIENT rule

To save the rule, commit all changes to the repository. Select  from the Construction Workbench menu.File > Commit

You can also commit changes by clicking the  button  in the toolbar or pressing Ctrl+M on your keyboard.Commit

HELLO_CLIENT rule
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2.  

Adding a Server Rule

For our sample application, the server rule receives the message that the user types and copies it to the OUTPUT_MESSAGE field. This rule also
echoes the text in the execution log.

Right-click the  rule on the  tab of the Hierarchy window and select . The Rule Painter displays,HELLO_SERVER Project Open Rule
showing a blank window.
Type the following rule in the rule window:

*>
Rule: HELLO_SERVER
<*

dcl
LOGSTRING CHAR(256);
enddcl
map INPUT_MESSAGE of HELLO_SERVER_IV to LOGSTRING
print LOGSTRING
map 'Received  message from HELLO_CLIENT: ' \+\+this
INPUT_MESSAGE of HELLO_SERVER_IV to OUTPUT_MESSAGE of
HELLO_SERVER_OV
return

Your window should look like the one shown below:

HELLO_SERVER rule
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To save the rule, commit all changes to the repository. Select  from the Construction Workbench menu.File > Commit

You can also commit changes by clicking the  button  in the toolbar or by pressing Ctrl+M on your keyboard.Commit

Verifying Rules

Use the  option to specify the execution environment (for example, C, Java, or Cobol) of the rule.Verification Language

Open the Rule Painter window for a rule.
Right-click in the Rule Painter window for the rule and select  . This ensures that AppBuilder verifies the ruleVerification Language > Java
for a Java environment, since you are designing the Hello World Application as a standalone, Java application.
You can also set the verification language by selecting  from the Construction Workbench menu.Build > Verification Language > Java
Right-click in the Rule Painter window for the rule and select  from the pop-up panel.Verify

You can also verify a rule by selecting  from the Construction Workbench menu or by clicking the  button  in theBuild > Verify Verify
Text Editor - Tools toolbar. 
The system checks the rule and displays the results on the  tab of the Status window, as in .Verify Verify tab of Status window

Verify tab of Status window

If there are errors in the rules, double-click the error or warning in the Status window. AppBuilder displays the associated line of the rule in the
Rule Painter window.
After verifying that all rules are correct, commit all changes to the repository. Continue with .Preparing and Executing the Application

Preparing and Executing the Application

When AppBuilder prepares your application, it performs the following functions:

Transforms the rules you have written in the Construction Workbench into an executable program
Compiles the source code for any third-generation language components used by your rules
Prepares any files your rules or components access, and creates their corresponding database tables
Prepares the sets the application uses
Makes available to the runtime environment the menus, icons, windows, and workstation reports that comprise your application end-user
interface
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2.  

Tasks in preparing and executing the application include the following:

Setting Preparation Options
Preparing the Application
Executing the Application

Depending on your planned deployment and execution environment, you may also be able to prepare mainframe rules for test execution on the
workstation or check the syntax of mainframe rules.
You can prepare a single element in the hierarchy (for example, a rule or function) or the complete application.

Setting Preparation Options

We prepare the sample application as a standalone Java application.

Select  from the Construction Workbench menu.File > Project Options
The Project Options dialog displays, as shown in the following figure.
You can also access the Project Options dialog by right-clicking an object on the  tab and selecting  from theProject Project Options

pop-up menu or by clicking the  button  in the toolbar.Project Options

By default, the system uses the objects specified when you created the project. See  and Creating the Project Create
.New Project window

Project Options dialog

 * *

Configure the following options for the Hello World Application.

Field What to
enter

Description

By default
prepare as

Standalone
application

The sample application runs locally on your PC and does not require connection to a database or
server.

Application
options

Java
application

AppBuilder prepares the application and rules to execute in a Java environment.
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1.  

2.  

3.  

Database type N/A The sample application runs locally on your PC and does not require connection to a database or
server. 

Leave the other database fields (  ,  ,  and URL) blank.Database name User name Password

Use
SQLJProfile
Customizer

N/A This utility augments the profile with DB2-specific information for use at run time.The SQLJ translator
performs analysis on the SQLJ source file by checking for incorrect SQLJ syntax. For the sample
application, this box does not need to be checked.

Include
mainframe
rules

N/A The sample application runs locally on your PC and does not require connection to a mainframe host.

Configurations N/A Since you are using a standalone application, there is no need to set configurations.

Partitions N/A Since you are using a standalone application, there is no need to set partitions.

Click  .OK

Preparing the Application

The Construction Workbench contains two commands for preparing applications:  and  . The Prepare function preparesPrepare Super Prepare
only the selected object. The Super Prepare function prepares the selected object and its children.
For the sample application, we Super Prepare the  function, thereby preparing the entire project.HELLO_WORLD
To Super Prepare the project, select the  function in the  tab of the Hierarchy window and select HELLO_WORLD Project Build > Super Prepare
from the Construction Workbench menu. The system displays the status of each object in the  tab of the Status window, as shown inPrepStatus
the following figure.
You can also prepare the function by right-clicking the  function and selecting  from the pop-up menu.HELLO_WORLD Super Prepare

Status window with Prep Status tab

If any object does not prepare successfully, right-click the object and select  . The system displays a detailed error report for the object.Details

The  tab maintains a history of each  and  command submitted.Prep List Prepare Super Prepare

Executing the Application

After preparing the application successfully, commit all changes to the repository. Select  from the Construction Workbench menu.File > Commit

Select  from the  menu.Run > Java Construction Workbench
The Java Client displays, as shown in the following figure:

Java Client

Click . A drop down list opens. Click .Hello World Application HELLO_CLIENT_PROC
The system displays the following message: Do you wish to start RuleView?
RuleView is a debugger that can be used to test and debug an AppBuilder rule. Refer to the  for details onDebugging Applications Guide
using RuleViewer.
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Click  .No
The Hello World Application window displays, as shown in the following figure:

Hello World Application

 * *

Type your message in the  field and click  .Enter Input Message Call Server
The system copies your message to the  field.Output Message from Server
To close the application, click  .Close

Congratulations! You have successfully developed an application using the AppBuilder environment. Refer to the other guides in the AppBuilder
library for additional information on developing custom applications for your business.

Creating the Configuration Hierarchy

For the sample application, we created a Java application that ran locally on your PC. This standalone application did not require a deployment
configuration. However, AppBuilder projects can be built for a number of different configurations. This section explores some of the possible
configurations if you were to deploy the sample application to other runtime environments (that is, a distributed application).
Although you can build the configurations in this section, the application will not run from your PC. These procedures are only examples of the
preliminary steps involved in developing an application. Deploying them on other machines might involve further configuration. For information
about deployment of an application, refer to the  .Deploying Applications Guide
AppBuilder installs an example file, SAMPLES/HELLO_WORLD.ZIP. The files in this example may be useful to view for comparison. The
configurations discussed in this chapter are based on using those sample files.

The sample files provided in the zip file must be imported into a repository, using the Repository Administration Tool. For further
information and details on the import process, refer to Repository Administration Guide for Workgroup and Personal

 .Repositories

The configuration hierarchy associates client processes and logical servers with databases and physical machines, creating an Application
. An application configuration groups a number of  , typically belonging to a single deployment configuration for anConfiguration Object partitions

AppBuilder project. These partitions contain the necessary information to prepare the objects of the application hierarchy to the correct locations
in a preparation network. Use the  tab of the Hierarchy window to build the configuration hierarchy.Configuration
Tasks in creating the configuration hierarchy include the following:

Using the Configuration Tab
Creating Sample Configurations

For detailed information about configuration options, refer to the  . See also  and Deploying Applications Guide Application Configuration Object
.Partition

Using the Configuration Tab

When a project has been opened, a Project and a Configuration tab display in the Hierarchy window. Click the Configuration tab of the Hierarchy
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window to display the configuration hierarchy. Similar to the Project tab, the Configuration tab shows a hierarchy of information about the current
project. The configuration objects can be expanded to show the objects that make up that configuration. The example in the following figure
shows a sample configuration hierarchy with multiple partitions.

Configuration diagram

 

See the following topics for more information:

Hierarchy - Objects Toolbar
Application Configuration Object
Partition

Hierarchy - Objects Toolbar

The Hierarchy - Objects toolbar provides a method for quickly adding configuration objects to your configuration hierarchy.

To display the toolbar, select  >  from the  menu (see View > Toolbars Hierarchy - Objects Construction Workbench Hierarchy Objects
).toolbar (used with Configuration tab)

Hierarchy Objects toolbar (used with Configuration tab)
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You can also add objects to the configuration hierarchy by using one of the following methods:

Right-clicking an object in the configuration diagram and selecting  .Insert
Selecting an object in the configuration diagram and selecting  from the Construction Workbench.Insert

For detailed information about configuration objects, refer to the  .Deploying Applications Guide

Application Configuration Object

An application configuration object groups a number of partitions units, typically belonging to a single deployment configuration. This object
contains the information needed to prepare a distributed application, to migrate it to a production environment, and to administer the application at
runtime. Typically, each project contains a single application configuration. For detailed information on configuration objects, refer to the 

 .Deploying Applications Guide

Partition

Partitions define the associations between a  or  and its associated machines or databases. Each partition must be associated with anclient server
application configuration.

Client partitions ? Client partitions contain the processes of a project that execute on the client-side. When you add a process from the
project hierarchy to the configuration, AppBuilder automatically includes all the necessary child objects (for example, rules or views). In
addition, the client partition includes a machine object that indicates the client runtime environment.
Server partitions ? Server partitions include a  object that defines the type of server (for example, an EJB server). The serverserver
partition also includes a machine object and the processes and rules that execute on the server-side.

During preparation, use the Project Options dialog (as shown in ) to select the specific configuration or partitions to use.Project Options dialog

Creating Sample Configurations

The standard AppBuilder installation includes the following sample configurations for the sample  . Refer to the Hello World Application Deploying
 for information on using these configurations.Applications Guide

Thin Client
EJB Server (and Java Thick Client)
Servlet (C Server with HTML Client)
RMI Server with Java Client

Thin Client



When creating an application configuration for a thin client (HTML) application, the client configuration requires a machine object (except when
the client is prepared locally). The client partition should also contain the process object that contains the application rules. The following figure
illustrates a thin client partition:

Sample thin (HTML) client configuration

EJB Server (and Java Thick Client)

When preparing an AppBuilder application to be deployed to a Java Enterprise Java Bean (EJB) server, configure the server interface for the
server partition as  .  illustrates a sample Java client and EJB server configuration.EJB Sample EJB server (with Java client) configuration

Sample EJB server (with Java client) configuration



Servlet (C Server with HTML Client)

When preparing a servlet-based application AppBuilder creates the necessary Java classes, HTML, CSS, JavaScript, and images for the client.
The following figure illustrates a sample HTML client and C server configuration.

Sample Servlet configuration



RMI Server with Java Client

The following figure illustrates a sample RMI server and Java thick client configuration.

Sample RMI configuration
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Product Glossary

This glossary defines terms used in the AppBuilder environment.

The terms are listed alphabetically.

Numbers G-H R

A I-J S

B K-L T

C M U-V

D N W-X-Y-Z

E O

F P-Q

Numbers

3270 Converse

An AppBuilder runtime product that provides a user interface on 3270 terminals - also called non-programmable terminals (NPTs) - which are
character-based (in contrast to pixel-based workstations). 3270 Converse uses the same data definitions as on the workstation display panels,
although 3270 terminals cannot use some of the more advanced workstation features. The AppBuilder environment supports systems that run on
both workstations and 3270 terminals.

A



agent

Any process that performs some communications service, such as eventing. See also  .AppBuilder Communications

alternate identifier

A non-primary identifier. Part of an . See also  .entity primary key

API

See  .application programming interface (API)

AppBuilder Communications

The internal communications interface for the AppBuilder environment.

AppBuilder environment

The collection of systems and tools that comprises the system development environment within which analysts and programmers create software
and the execution environment where end users access completed applications.

AppBuilder program group

A program group on your desktop that contains icons that you click to launch the  ,  applications,Construction Workbench repository administration
or other AppBuilder programs.

AppBuilder system service

Single process that handles AppBuilder communications. See .Management Console

application configuration

A configuration object that groups a number of  s, typically belonging to a single deployment configuration for an AppBuilder project.partition

application programming interface (API)

An interface that allows an application program to use specific data or functions of the interfacing program.

associative entity

A type of entity used in an  between two or more fundamental (kernel) entities. It stores information about a Entity Relationship Diagram (ERD)
 .relationship

attribute

The smallest unit of information that describes a single characteristic (such as name, kind, usage, or other details) of an entity object in an Entity
 . An attribute in an entity/attribute hierarchy is shown as a child of the entity it is providing information for. AttributesRelationship Diagram (ERD)

can also be displayed within entity rectangles in the  . See also  and .Entity Relationship Diagram tool attribute entity property

attribute entity

An entity type in the  that is a single characteristic of any of the following entity types:  ,  ,  ,  ,Information Model entity relationship identifier attribute
or  .data type
For example, a  entity might be defined by attributes called  ,  ,  , and so forth.CUSTOMER FIRST_NAME LAST_NAME STREET_ADDRESS
See also  ,  , and  .data type foreign key primary key

audit information

Information stored in a  containing the user name and the name of the project that owns an object, along with the date and time it wasrepository
created and last maintained.

autostart server

A server technology that uses a third-party  - INETD for TCP/IP, SNA Server/6000 for LU6.2 - to spawn an instance of the server for eachdaemon
connection request it receives; the server instance ends when the connection is closed. Until the connection with the client is closed, the server
instance is dedicated to satisfying service requests from that client. See also  and  .banking server forking server



B

banking server

A server technology that uses a pre-spawned worker for each connection request it receives; the worker persists after the connection is closed.
Additional workers are spawned as necessary. Until the connection with the client is closed, the worker is dedicated to satisfying service requests
from that client. See also  and  .autostart server forking server

base objects

For MLUI development, the base objects (windows and sets) are the initial source of the newly-created language panels and display values. The
base window or set objects refer to one of the following:

the first window or set created in AppBuilder MLUI
for windows and sets created in a pre-MLUI AppBuilder, the existing windows and sets are marked as the base objects when a second
language is added to that base window or set

breakpoints

A point you set in AppBuilder's debugging tool,  , to halt your application so you can examine, and modify, the data in any of its views.RuleView

business object

An entity type in the  that is a data entity, or set of related data entities, linked to manual and automated processes that createInformation Model
and manipulate the data. Events initiate the processes tied to the data entities. Thus, a business object consists of the following:

A data object shown in a data object Entity Relationship Diagram (ERD)
All of its state objects shown in State Transition Diagram
All of the process objects for the states shown in a set of Process Dependency Diagram (PDD)

C

candidate identifier

An  designated as a potential  . The elements of a candidate identifier must uniquely identify the entity.identifier primary key

cardinality

A method for defining the kind of numeric relationship between two entities. The following table identifies the types of cardinality.

Cardinality Description and example

One to one (1:1) A customer HAS one account.

Zero or one (0:1) Also called optional-one. 
A business CAN BE OWNED BY a parent company.

Zero of many (0:M) Also called optional-many. 
A parent company CAN OWN many companies

One to many (1:M) A customer PLACES many trades.

Many to many (M:M) Customers OWN many securities.

characteristic entity

A dependent type of  that requires an instance of another entity in the model.entity
For example,  requires an instance of the  entity.Customer Address Customer
A characteristic entity type contains a  type's repeating or optional attributes. Because a characteristic entity type must include itskernel entity
base kernel entity's identifier in its own identifier, characteristic entity types are always dependent. See also  and  .attribute identifier

chart object

A  object that graphically displays occurring views.Window Painter

check box

A  object that allows end users to indicate an on/off or yes/no condition. A check box is a small square that contains a check markWindow Painter
when users select the  or  condition. You can use check boxes singly or in groups to indicate choices that users can select in anyOn Yes



combination. You can also use the information users provide in check boxes to set flags.

CICS

Customer Information Control System - a family of application servers and connectors for online transaction management and connectivity from
IBM.

class

For object-oriented programming, a class is defined as a template for building objects with identical properties (variables) and methods
(functions).

clear

To remove an item from the display but not  it from the  .delete repository

client

A system that depends on a server to provide it with programs or access to programs.

code page

A form of character encoding that defines the characters your workstation displays. Each code page assigns a number (1 to 255) to every letter,
number, symbol, and other character common to a particular country.

code reuse analysis (CRA)

A method of measuring the number of objects in an application that are used more than once rather than being recreated. See also  .reuse

code, reentrant

See reentrant.

collapse

An action in the  that "hides" objects below the object you select to collapse. Use the  action to restore a collapsedHierarchy window explode
object.

column

An object type in the  that represents a column in a relational table. One or more attributes translate to a column that allInformation Model
instances of the object type share. See also  ,  , and  .attribute relational model table

combo box

A  object that combines the functions of an  and a drop-down  , which displays a list of objects or settings choicesWindow Painter edit field list box
that users can scroll through and select from to fill in the edit field. Or, users can type their choice in the edit field, which need not match the
choices in the list if the combo box is not "protected." The combo box is linked to a  , which is linked in turn to a  that contains the displayedfield set
values.

commit

An action of saving to the  any changes you make in a workbench session since startup or the last commit or  .repository rollback

component

An object type in the  that contains code written in a third-generation computer language (such as C, COBOL, JAVA, or PL/I) toInformation Model
do things the  either cannot do or cannot do quickly enough. This might be a complicated arithmetic algorithm, such asRules Language
exponentiation, non-SQL data access logic, such as an IMS database interface, or hardware-specific functions, such as time/date stamping.
Components also support system re-engineering, whereby existing applications can be defined to the Enterprise Repository. Because
components are written in a language specific to one environment, they are not portable between environments. AppBuilder provides some
system components as an extension of the  .Rules Language

Component Folder

A container for external files that support components.

Configuration Tab



A  tool in the Hierarchy window for mapping logical servers and client processes to databases and physical machines toConstruction Workbench
specify how an AppBuilder application is to be deployed on target machines. It encapsulates the information you need to prepare the application,
distribute it, and administer it at runtime.
See also  .logical server

connector

An  in a  that generically describes a line that connects two objects together.object Process Dependency Diagram (PDD)

construction tools

In AppBuilder in the , these are the tools to construct an application from what has already been designed using Construction Workbench drawing
. These tools include the following:tools

Report Painter
Rule Painter
Window Painter

Construction Workbench

The AppBuilder development environment that you can use to design the application, define the hierarchy, create the end-user interface, and
construct deployment configurations. You can also use the Construction Workbench to   on local or remote machines. Theprepare objects
Construction Workbench includes , , and the  debugger.drawing tools construction tools RuleView

Constructor

An operation inside the class that creates the object and/or initialize its state.

converse

A verb in the  and a relationship in the  that defines what a  does to display a window or print a report.Rules Language Information Model rule

copybook

A term originating in the COBOL environment for a file included in the source code of a component or subroutine. In AppBuilder applications, a
copybook typically contains a definition of the data structures that the component or subroutine use.

CRUD matrix

A matrix that maps one kind of  against another to show the  between an entity and the process that creates, reads, updates, andentity relationship
deletes it.

C (Create) - The entity is created with a new instance.
R (Read) - The entity is read to obtain data, check validity, or to get a related entity.
U (Update) - The entity data content or relationships are changed.
D (Delete) - The entity instance is deleted.

current language

In MLUI development, the current language is a Workbench Options setting whose purpose is twofold. The MLUI application is prepared using the
Current Language setting if language panels or display values exist for the Current Language. AppBuilder opens each new language panel or set
display value in the Current Language, so that you can more easily develop large portions of your application.

current system

An entity type in the  that represents a non-AppBuilder system interfacing with or replaced by a function.Information Model

customer

An entity type in the  , an instance of which represents a AppBuilder application user who has been identified to theSecurity Information Model
security database and assigned a user ID and password. Each customer is a member of a  .customer group

customer group

An entity type in the  that represents a logical collection of  . Security restrictions are applied to customerSecurity Information Model customers
groups.

D



daemon

A process that executes in the background or provides some service that does not require input or intervention.

data definition language (DDL)

Describes data and their relationships in a database.

data flow

Indicates movement of information or data in a diagram.

data item

The smallest unit of named data that has meaning in describing information.

data link

A connection between a  object and an object in the hierarchy (in the  ). For an application's user interface to functionWindow Painter repository
correctly, you must use Window Painter to create data links between most Window Painter objects and objects in the hierarchy.
For example, to display the value of the  field on one of your application's windows, paint an  object in the window and thenLAST_NAME edit field
create a data link between that edit field object and the  value. Remember that  must be in the  the window owns.LAST_NAME LAST_NAME view

data model

A logical data map that represents the structure of an enterprise's information. A data model describes the functional dependencies and
associations among data items, independent of software, hardware, and machine performance.

data modeling

A discipline that methodically defines the discrete bits of information, such as a customer or transaction, an organization needs to conduct its
business. A conceptual data model is refined to a fully attributed logical data model.

data object

A collection of data referred to by a single name that links together the smallest unit of data users need to perform a meaningful business activity.

data object entity-relationship diagram (data object ERD)

A diagram that identifies a set of highly related or coupled entities grouped as a result of partitioning the  It containslogical data model (LDM).
related kernel, characteristic, associative, and intersection entities. The focus of the data object ERD is a specific  that is furtherkernel entity
defined by the entities around it. Data object ERDs show the relationships between kernel entities.

data store

An entity type in the  that represents an existing database or a file a current system accesses.Information Model

data type

(1) An object type in the  that contains a physical description of data, such as size and format.Information Model
(2) A property of a data item that indicates the types of information it can contain.

data universe

The collection of data structures a given  can see, which includes the following views:rule

Its input, output, and work views
The window view of any window it converses
The section view of any report it converses
The file view of any file it accesses
The input and output views of any rule it uses
The input and output views of any component it uses

A rule can change information in any of these views except information in its own input view or in the output view of any rule or component it uses.

Database Diagram tool

A  tool for modeling a database by modifying tables and their primary, index, and foreign keys. See also Construction Workbench relational model
.



database management system (DBMS)

Software that defines, creates, manipulates, controls, and manages a database.

DBCS

See  .double-byte character set (DBCS)

DBMS

See  .database management system (DBMS)

DDE

See  .dynamic data exchange (DDE)

DDL

See  .data definition language (DDL)

debugging

The process of finding and fixing runtime errors when the application attempts to perform a prohibited task and logic errors with correct code but
not what was intended in Rules Language code. When you run the application, it can be monitored and debugged with the help of the RuleView
debugger.

default language

Default language is the language of existing non-MLUI application. For new MLUI applications, the default language is the language of the base
.objects

default repository

A  populated with system  s that AppBuilder provides, such as system components.repository object

deferred component

A system  , in a C application, that does not execute immediately when the system executes a  statement. Thecomponent USE COMPONENT
component's execution is deferred (or delayed) until the next  statement executes.CONVERSE WINDOW

delete

An action that permanently removes an  from the  and any place it may appear, such as a drawing. See also  .object repository clear

denormalize

A process in the  that lets you copy a  from one table to another through a  . Contrast with Database Diagram tool column foreign key normalization.

distributed application

An application that can be installed and distributed throughout the network across many systems and platforms.

domain

A set of acceptable values that business rules establish for an attribute or field, for example, annual salary must be greater than $10,000 and less
than $200,000.

donor entity

An entity that passes one or more foreign keys to a recipient entity. See also  and  .foreign key recipient entity

double-byte character set (DBCS)

A set of characters in which each character is represented by two bytes. DBCS enables national language support (NLS), a standard that
supports Asian languages with thousands of characters. The AppBuilder environment supports the double-byte character set. See also 

 .single-byte character set (SBCS)

download



The process of copying one or more objects from the  on the mainframe to the  on a workstation. This isEnterprise Repository Personal Repository
also called  . See also  .refresh upload

drawing

An object type in the  that stores the output of the diagramming tools.Information Model

drawing tools

In AppBuilder in the , these are the tools to design an application that can later be constructed (using ).Construction Workbench construction tools
These tools include:

Database Diagram tool
Entity Relationship Diagram tool
Process Dependency Diagram tool
State Transition Diagram tool
Window Flow Diagram tool

driver rule

The  controlling the highest level of the application logic. Often this is the  .rule root rule

dynamic data exchange (DDE)

A protocol for moving data among different applications. The AppBuilder environment includes DDE components so you can create AppBuilder
applications that can interactively access other Microsoft Windows applications. This is an excellent way to connect third-party workstation
applications to mainframe applications and information sources.

dynamic linkage

Allows the AppBuilder runtime system to receive control and either load or locate a load module before passing control to it. You usually employ
dynamic linkage to test each module separately in development. In the production environment, static linkage binds the modules together at
link-edit time and they then execute as a single module.

E

edit field

A  object that corresponds to a field in the hierarchy (or repository) and in which data is displayed. If the field is not protected (thatWindow Painter
is, read-only) users can type and modify the edit field's data. See also  .data link

EJB

See  .Enterprise Java Bean (EJB)

empty repository

Reference file, with no objects created.

Enterprise Java Bean (EJB)

Container for server-side Java.

Enterprise Repository

A mainframe-based  that contains all the entity types and relationships that describe an organization's information systems.repository
In a typical AppBuilder development process (unless you are using a  ), you must  enterprise repository objectsWorkgroup Repository download
that you may be able to reuse to your  . After creating your application,  the objects (including any new objects youPersonal Repository upload
created) back to the Enterprise Repository. You can then use the  process to move your work into a testing and/or productionmigration
environment.

entity

An object type in the  that describes the business data an enterprise uses.Information Model
For example, an enterprise that rents automobiles might have entities for  and  . You define entities in the CUSTOMER RESERVATION Entity

 and refine them to file objects at any stage of development. Use  s to define entities, and relationship objects toRelationship Diagram tool attribute
describe the relationships between two entities.
See also  .object type



Entity Relationship Diagram (ERD)

A graphic representation of entities and their relationships with each other. Use the  to draw an ERD - also calledEntity Relationship Diagram tool
a  . Typically, labeled boxes represent entities and lines connecting the boxes are the relationships between them. The logical data model (LDM)

 of relationships is often expressed in ERDs.cardinality

Entity Relationship Diagram tool

A  drawing tool for creating a data model of an application or system. You produce an Construction Workbench Entity Relationship Diagram (ERD)
by creating and editing the entities and the relationships between them.

ERD

See  .Entity Relationship Diagram (ERD)

event

An entity type in the  that represents an incident that causes a data object to change states. An event happens at a particularInformation Model
point in time, has no duration, and triggers a set of processes. Events may be an  or .explicit event implicit event

event trigger

A drawing object in the  that represents the relationship between a process and the event it triggers.State Transition Diagram tool

event-driven processing

A processing method that creates and traps system and user events in addition to graphical user interface (GUI) events.

exceptions

Entities outside the rebuild package that rebuilding can affect.

execution environment

The combination of hardware and operating systems on which end users access a completely developed and tested application.
Do not confuse the execution environment and the . AppBuilder applications can execute in both development andproduction environment
production environments. In the development environment, you can move applications between the parts of the . InConstruction Workbench
contrast, the production environment is only a runtime environment that provides end users access to the application.

exit

A user exit routine that receives control at predefined user exit points.

explicit event

Explicit events are defined within a hierarchy. See also .implicit event

explode

An action in the  that displays hidden relationships or objects in the hierarchy. See also  .Hierarchy window collapse

export file

A file that contains information and objects from a repository after the export action. There are two types of export: Full repository export and
migration export.

external agent

An object existing outside a system that provides information to or receives information from the system.

F

field

An object type in the  that defines the smallest subdivision of data, such as a column in a DB2 table, or part of the input orInformation Model
output definition of other object types, such as the view a window owns. Views organize fields into data structures.



For example,  could appear on a window or screen in a physical application, be passed from one rule to another, or beCustomer Last Name
stored in a database.
A logical attribute may become a physical field.

file

An object type in the  that represents a physical data file or table on a disk. Rules and components must be related to the fileInformation Model
objects that represent the disk files they read and write.

ftp

File transfer protocol. Used in AppBuilder for migrating objects between repositories and for communications between machines. See .migration

focus

The currently active tool, object, or window that receives input from the mouse or keyboard.

forking server

A server technology that invokes a new process for every single client connection that ends when the connection is closed (spawns a child
process for each connection request it receives; the child process ends when the connection is closed). Until the connection with the client is
closed, the process is dedicated to satisfying service requests from that client. See also  and  .autostart server banking server

foreign key

A unique index into another  that can be used to join the two tables. A foreign key is one or more columns that uniquely identifies rows intable
another table that associates two entities through a relationship.

forward engineering

A systems development method in which a project team first specifies a  and then derives a physical model from it. Thelogical data model (LDM)
forward engineering process in the  translates logical objects ( , , and  ) into relationalEntity Relationship Diagram tool objects identifiers attributes
objects ( , , and ).tables keys columns

frontier

Signifies the boundary between two different environments, for example, the boundary between the workstation and the mainframe execution
environments.

frontier rule

See  .remote rule

functions

An object type in the  that represents the highest-level business function; that is, the purpose of the application. At executionInformation Model
time, functions appear as a desktop icon or menu option that the end-user can access. Functions contain groups of  that subdivide theprocesses
application. See also  .projects

G-H

GUI

graphical user interface. For example, in AppBuilder the Construction Workbench provides an application development environment GUI and the
Management Console provides a communications control GUI.

hierarchy

The structure that defines the relationship of a AppBuilder application and specifies how the application executes. See also  .Hierarchy window

Hierarchy window

A window in the  that contains the following tabs:Construction Workbench

Project tab - The  and functional diagram of the applicationhierarchy
Configuration Tab - The configuration and partitioning information for preparing and deploying a distributed application
Repository tab - The  and relationship of a specific object within the hierarchy repository
Inverted tab - An object's inverted hierarchy (showing ownership of a specific object within the application's hierarchy or  )repository



host repository

See  .Enterprise Repository

Host Workbench

An interface to the enterprise repository from the mainframe that provides software developers with various tools for generating and testing
mainframe-only and host-server application code. See also  and  .rule component

HTML

hypertext markup language

I-J

identifier

An object type in the  that consists of one or more attributes that uniquely identify an instance of a parent entity orInformation Model
cross-reference another entity. An identifier is a logical key that becomes a physical key during database design.

impact analysis

The first step performed before a migration to determine which modules need to be moved and what effects (if any) the migration will have on
other modules. Impact analysis can tell you what must be rebuilt so you do not have to manually trace every relationship the field is connected to.
See also  .migration

implementation name

A  type of all  s that uniquely identifies within the operating system each  of that object.property object type instance
For example, the implementation name of a rule specifies the name of the executable file it generates. Implementation names are required
because some environments have special naming constraints.

implicit event

Implicit events are defined externally. Implicit eventing uses a subcell table to identify the routes to the children of the local host, a trigger table to
identify the triggering service, and an event table to identify the triggered service, message, or event. The subcell, trigger and event tables are
located in AppBuilder\NT\RT. Implicit events are ONLY supported by C client and server.
Implicit eventing is a type of asynchronous processing in which eventing logic resides in text files rather than application code. Implicit eventing
can be used for a variety of reasons. For example, one may use it when monitoring the activity of remote services closely in the initial stages of
implementing a system but only intermittently after that, in response to unusual network demand. Another example would include wanting to be
able to react to a period of market instability by specially logging all trades affecting a particular stock. In both these situations, you'd want to avoid
embedding in your application a function that will eventually become superfluous. Implicit eventing addresses the temporary requirements each
situation imposes by maintaining eventing logic in text files rather than program code.

IMS

Information Management System, a transaction and hierarchical database management system from IBM.

index key

One or more non-unique s that can locate more than one of an entity's instances.column

Information Model

A collection of s used to model your business and build a AppBuilder application. These objects and their relationships are the buildingobject type
blocks of your application. Create instances of these objects (for example, rules, windows, fields, etc.) to build the application.

INI file

A text file that contains product configuration or initialization information. It consists of a series of named sections, with each section listing one or
more keyword parameters and their assigned values. Each section starts with the section name enclosed in brackets, for example [Java Settings].
Each keyword parameter is associated with the value after the equals sign, such as  .OPTIONS=/A/B

input view

See  .view

instance



See  and  .object instance relationship instance

Integer

A  that denotes a four-byte integer between -2,147,483,647 and +2,147,483,647.data type

Interactive System Productivity Facility (ISPF)

An IBM licensed program that is a full-screen editor and dialog manager under the mainframe operating system. ISPF is used to write application
programs and generate standard screen panels and interactive dialogues between the application programmer and terminal user.

intersection entity

A type of entity that exists because of the association of two or more kernel entity types. Unlike the  type, the intersection entityassociative entity
type does not contain any non-key attributes. The primary way to resolve many-to-many relationships between entities is to create intersection
entity types.

inverse scope processing

Process in which rebuild analyze looks at every entity in the rebuild package, whether or not its parent has changed, to determine whether the
date it was last changed is more recent than the date it was last installed.

job control language (JCL)

A control language on the mainframe that submits batch jobs to the mainframe operating system.

K-L

kernel entity

A basic kind of entity, such as Customer, Product, and Account, that is independent from any other entity. This independence does not imply that
it cannot have a relationship with other objects. A kernel entity must be unique with its own  and not need relationships with any otheridentifier
entity, although it can have them.

key

(1) One or more attributes that comprise an entity's unique  . The key structure depends on how the business recognizes the entity.identifier
For example, the  attribute may uniquely define the key for the  entity.Employee Number Employee
Different types of keys include:  ,  , and  .alternate identifier foreign key primary key
(2) An object type in the  that represents a key, which is one or more unique columns that identifies one or more instances-rowsInformation Model
in a table-of an entity.
See also  ,  , and  .index key foreign key primary key

keywords

A columnar list of words that you can use to associate objects stored in a  .repository

Language Editor

An AppBuilder tool used to manage repository language objects (used in MLUI development).

leaf process

A process that is defined by only one  (a  ). Another process  defines a leaf process, which describes a business activity thatrule root rule never
comprises a  - in effect, a single application.logical unit of work (LUW)

line anchor

An object in the drawing tools that indicates the end of a line or a movable area of a box. You can select a line anchor and drag it, changing the
size and/or location.

list box

A  object that is a rectangle with scroll bars. A list box can display database records as rows and columns. Users can choose oneWindow Painter
of the selections in the list box but cannot edit its information. A list box should be linked to a field of a view that occurs more than once. A list box
is similar to a  but can display only one column (that is, one  ).multicolumn list box field

local repository



See  .Personal Repository

local rule

A rule located in the current environment.

location

An entity type in the  that represents a physical business location or category of location at which a procedure is carried out orInformation Model
data is manipulated.
For example: An office, installation, or factory are typical location entities.

logical data model (LDM)

An extension of the conceptual data model, the LDM represents the business area's information needs, focuses on what the business is (rather
than what it does), and is depicted in an  . Entities in an ERD are related to each other according to businessEntity Relationship Diagram (ERD)
rules. The  , relationship names, and text are attached to the relationships. The LDM is an idealized model that is independent ofcardinality
software and hardware.
Entities in the LDM are:

Assigned the relationships and cardinality between two entities
Defined with attributes
Described with text
Assigned identifiers

See also  .Entity Relationship Diagram (ERD)

logical process

An entity type in the  that specifies an activity that transforms input data. It defines what must be done but not how to do it.Information Model

logical server

An object type in the  that allows an application to define groups of rules for the purpose of being offered on a server machine.Information Model
A logical server object has no inherent machine information, but is itself associated with one or more machines using configuration units. See also

 .Configuration Tab

long int

A "long integer", a data type that denotes a four-byte integer between -65,534 and +65,534. Often just simply called "integer" or "int". Contrast
with .smallint

logical unit of work (LUW)

A business activity that can be (or should be) performed in isolation and in its entirety.
For example, adding, deleting, and updating a customer record are all discrete business activities, and each constitutes a LUW. On the other
hand, accessing a customer file is not an LUW because it is not an independently performed business activity.
A logical unit of work typically consists of a combination of activities, such as:

Obtaining data for a new customer record
Accessing a customer file
Creating a new record
Populating a new record with data
Confirming the successful addition of a new customer record

Loopback adapter

This is a tool for testing where access to a network is not feasible, such as on a laptop on which AppBuilder can be installed. This is a third-party
tool available from Microsoft.

LUW

See  .logical unit of work (LUW)

M

Management Console

The AppBuilder program that maintains and coordinates AppBuilder communications and offers a graphical user interface to allow you to view
and modify the servers, gateways, and agents involved.



mainframe repository

See  .Enterprise Repository

mainframe rule

A  that executes tasks on the mainframe, typically updating corporate data. Although a host rule is not platform specific and can use anotherrule
host rule, it cannot use a  .workstation rule

marshalling

A technology for resolving incompatibilities between data definitions across platforms by converting a representation specific to the sending
platform to a platform-independent representation and then to a presentation specific to the receiving platform.

Matrix Builder

A  tool for creating matrices of relationships between objects in the repository. One use of the Matrix Builder is to create aConstruction Workbench
 that maps one kind of entity type against another to show the relationships between entities and the processes that create, read,CRUD matrix

update, and delete them. See also entity type and  .relationship type

menu bar

The list of choices that can be selected from a window. Selecting a choice does one of three things: displays a pull-down menu, displays a new
menu window, or invokes an application. See also  and  .pull-down menu window

Method

An operation upon an object, defined as part of the declaration of a ; all methods are operations, but not all operations are methods. Theclass
terms message, method and operation are usually interchangeable. In some languages, a method stands alone and may be redefined in a
subclass; in other languages, a method may not be redefined, but serves as part of the implementation of a generic function or a virtual function,
both of which may be redefined in a subclass.

migration

A facility that automates promoting software by exporting objects from one  and importing them to another. Between the export and therepository
import, you typically use the Analyze Migration Impact (AMI) facility. After the import, a generated report details what was moved. The migration
facility also provides configuration management, which automatically captures and stores the maintenance history of an application's
relationships.

Migration Workbench

A tool that lets you move objects from one  to another.repository

Multi-Language User Interface (MLUI)

The ability to build multiple user interfaces for one application, creating windows and sets in different languages.

modeless window

A type of movable, fixed-sized window that does not require users to take any action, so they can continue uninterrupted with the application.

module

An executable processing block such as a rule or component.

multicolumn list box

A  object that is a rectangle with scroll bars which contains columns and rows of information. A multicolumn list box can displayWindow Painter
more than one column-that is, more than one field. Users can select one of the choices in the list box and can edit any field that is not protected. A
multicolumn list box is linked to fields in a view that occurs more than once.

MVS

Multiple Virtual Storage, the predecessor to OS/390 and zSeries, a mainframe operating system from IBM. The related versions are MVS/XA
(extended architecture) and MVS/ESA (enterprise system architecture).

N



name

A property type of all object types that uniquely identifies each instance of that object. You name an object when you create it. Various restrictions
and conventions apply to naming objects. See also , , and .object type implementation name system ID

name service

An external service that provides information about network objects, such as the location of servers.

named pipes

An inter-machine communication protocol supported by IBM Microsoft Windows.

national language support (NLS)

The AppBuilder environment supports national languages (including those that require the  ) in two ways:double-byte character set (DBCS)

You can develop applications in languages other than English (such as German or Japanese)
The end-user interface can appear in different languages.

However, the  supports only one language at a time.repository

navigate

To move from an object in one tool to its corresponding place in another tool.
For example, you can navigate from an entity in an entity relationship diagram to the  that shows only the objects that entity isHierarchy window
concerned with.

normalization

A method of reducing data structures to their simplest possible form, eliminating redundancy while maintaining integrity. The primary purpose of
data normalization is to refine a view of entities and attribute relationships, and provide unique access to it. Contrast with  .denormalize

O

object

Either an object type or a relationship in the  . Thus, a  , a  , and the  relationship between them are allInformation Model rule window converse
objects.

object property

The characteristics and properties of an object type. All AppBuilder object types have at least two properties:  and .name system ID

object instance

An object type a  user creates. See also  .Construction Workbench object type
For example, the  rule is an instance of a rule object.ADD_NEW_CUSTOMER

ObjectSpeak

A set of window-related functions and procedures you can use in your  code. Use the functions to query the properties ofRules Language
windows and their controls (such as push buttons, check boxes, list boxes, and the like). Use the procedures to set the properties or perform
some other action.

object type

Represents anything about which an enterprise or system wants to maintain or manipulate data. An object type can be tangible, such as a product
or a customer, or abstract, such as a financial transaction or loan agreement. An object type is a discrete element that represents a logical unit of
a business system. Relationships store the associations between object types.
The  describes the object types, such as rule, window, or component, and the relationship types between them that areInformation Model
available to application designers and developers. Other object types include components, events, functions, processes, rules, states, transitions,
views, windows, and so on. See also .object

occur

A property of the includes relationship that determines how many copies of a single view can appear. A view occurs if the property value is more
than zero.



organization

An entity type in the  that represents a logical unit or group, such as a department or division, that carries out a function in anInformation Model
enterprise.

orphan

An object in a hierarchy display that has no parent. Also called the root object.

output view

See  .view

P-Q

package

A logical grouping of Objects (Classes). Packages are commonly used to organize classes belonging to the same category [project, application,
etc.] or providing the same functionality

partition

An object in AppBuilder that defines that a segment of an application is to be prepared to (built on) a specific machine or platform type.

PDD

See  .Process Dependency Diagram (PDD)

Personal Repository

An AppBuilder  that resides on a workstation and contains the entity type and relationships that describe the application you arerepository
building. When you design and develop an AppBuilder application, you typically begin by downloading  objects to theEnterprise Repository
personal repository that you may be able to reuse. You finish by uploading your work, which includes new objects you have created.

pilot

A small application developed to evaluate the effectiveness of a particular design technique before undertaking production on a larger application.

prepare

To ready (by compiling, building, etc.) an object or application for execution, to create executable files from the source code and hierarchy. See
also  .Super Prepare

primary key

A required key consisting of one or more unique columns that identify a single instance-a row in a table-of an entity type.
For example,  could be the primary key of the  entity and  the primary keyEMPLOYEE_NUMBER EMPLOYEE CUSTOMER_ACCOUNT_NUMBER
of the  entity.CUSTOMER ACCOUNT

processes

(1) An object type in the  that describes business activities that comprise a logical unit of work. Each process represents aInformation Model
single application (leaf process), or a set of applications. You convert your hierarchy of processes into an end-user menu or icon.
(2) A  drawing object that represents an activity that transforms input data into output data.Process Dependency Diagram (PDD)

Process Dependency Diagram (PDD)

An AppBuilder diagram that illustrates the dependency of business activities (processes) on each other and the events that trigger their initiation.
The PDD shows a sequenced set of actions that occur in response to a given event stimulus. Process dependency modeling is a way to identify
and document internal, external, and time-delayed events that affect the business.

Process Dependency Diagram tool

An AppBuilder drawing tools available in the Construction Workbench for creating a .Process Dependency Diagram (PDD)

process trigger

A relationship in a  that connects an event and an action process or decision process, and that indicatesProcess Dependency Diagram (PDD)



when processes begin.

production environment

The runtime environment in which end users access a completed application.
Do not confuse the production environment and the . AppBuilder applications can execute in both development andexecution environment
production environments. In the development environment, you can move applications between the parts of the . InConstruction Workbench
contrast, the production environment is only a runtime environment that provides end users access to the application.

productivity

The amount of goods or services produced per unit of labor or expense. This equates to the number of function points divided by the amount of
labor devoted to the project.

projects

(1) User management information (that is, user, group, project, etc.) in a  .repository
(2) In a AppBuilder application, the project contains the business  and associated  (s).functions application configuration

property

A characteristic defining a particular instance of an object, usually defined in the Properties window for the object. An object or relationship's
name, system ID, data type, or range of possible values are all properties. See also  .object property
As a part of a , property is a variable declared in the class available for all the objects created in that class.class

protocol

A set of rules or transport mechanisms that describe communications.

prototype

A model or preliminary implementation suitable for clarifying requirements or for evaluating a system's design, performance, and production
potential. Prototypes are to demonstrate the look and feel of an application's user interface.
A prototype contains just enough code to show users the application's:

Menu structure
Navigation path between windows
Pull-down menus that initiate leaf processes
Reports

pull-down menu

A list of choices that users can display by selecting a choice on a menu bar.

purge

To remove objects from the personal repository without flagging them for uploading to the mainframe.

push button

A  object that is a small rectangle with rounded corners. It is not linked to an object. When users select a push button, it returnsWindow Painter
control to the rule that invoked the window and usually initiates an immediate action, such as further processing.

R

radio button

A  object that is a small circle and indicates an on/off or yes/no condition. A black dot fills the center of the circle when users selectWindow Painter
a radio button. A group of radio buttons within a group box indicates mutually exclusive choices. That is, users can select only one radio button in
the group because all the radio buttons in the group are linked to the same field.
See also  .data link

recipient entity

Receives one or more foreign keys from its donor entity. A  relationship determines whether an entity is a donor or a recipient. See also cardinality
 and  .donor entity foreign key

recursive



A module that can invoke itself. Use recursive modules with extreme caution.

recursive relationship

A relationship an entity or state has with itself. Recursive relationships are shown graphically with a line that loops from the entity or state onto the
same entity or state (itself).

reentrant

Code written so that it can be shared by several programs at the same time. Only one copy of the operating system routine needs to reside in
memory to serve all executing applications.

refresh

To download one or more objects from the  on the mainframe to the  on the workstation. See also Enterprise Repository Personal Repository
 .download

relational model

Expresses data structures and relationships in a table. In AppBuilder applications, a database diagram represents the relational model that results
from translating the logical objects in an  (entity, identifier, and attribute) to relational objects (table, column,Entity Relationship Diagram (ERD)
and key). See also  .Database Diagram tool

relationship

An object type in the  that records information about the relation between objects (even between relationships).Information Model
For example, if you have two  object types,  and  , you might have a relationship object called  toentity RESERVATION CAR_TYPE SPECIFIES
describe how they are connected.
An attribute object describes the relationship between objects (entities). Do not confuse the relationship object with relationship, which is the
relationship between any of the other object types in the .Information Model

relationship instance

A relationship that a  user creates.Construction Workbench
For example, the converse relationship between the  rule and the  window is an instance of aADD_NEW_CUSTOMER CUSTOMER_DETAIL
converse relationship.

relationship property

The characteristics of a relationship. Some relationships in the  have attributes; in traditional entity-relationship modeling,Information Model
relationships usually do not have attributes.

relationship type

A connection, association, or link between two object types.
For example, an instance of the include relationship type between the  and  entities is:CUSTOMER ADDRESS

 includes one or many  (s)CUSTOMER ADDRESS
Cardinality is the numerical condition a relationship has between its entities (in the example above, one or many).
Each relationship has a label. For example in the , the relationship between a rule object and a window object is a converseInformation Model
relationship. Some relationships in the  have attributes; in traditional entity-relationship modeling, relationships usually do notInformation Model
have attributes. Do not confuse a relationship type with the relationship object, which is a particular kind of  object type.Information Model

remote preparation

When compilation of a program is initiated on the development machine but is transmitted to another machine, where it actually takes place.

remote procedure call (RPC)

A technology for requesting services on remote platforms. Programs that use remote procedure calls execute synchronously: clients request a
service, wait for a response, and continue processing only on receiving it.

remote rule

A rule that is to be called from the current executing rule as a server rule using communications. Usually a remote rule is located on a different
machine than the rule calling it. Also known as a frontier rule, a remote rule is an entry point into a logical server from a client. Remote rules are
attached directly to one or more logical servers in the Configuration hierarchy (Configuration tab of the Hierarchy window).

remove

To remove objects from the Personal Repository and flag them for deletion from the Enterprise Repository when you upload. See also Enterprise



, , and .Repository Personal Repository upload

report

An entity type in the  that defines, in conjunction with the section entity type, the paper output an application (usually, a batchInformation Model
application) produces for an end user. You create a report and its associated sections using the  tool and .Report Painter Report Writer

Report Painter

This part of the AppBuilder product lets you control the layout and content of custom reports. After the layout is designed, you can then use 
 to create reports on the workstation that print on the mainframe.Report Writer

Report Writer

This part of the AppBuilder product creates custom reports on the workstation that print from the mainframe or Web application servers with the
Java Report Writer after you have designed the layout of a report with .Report Painter

repository

An organized body of information that can support business and data processing activities. See also  , Enterprise Repository Workgroup
 , and  .Repository Personal Repository

repository administration

Utilities for managing a . Use the Repository Administration tool to create, and edit, select, and delete repositories. See also repository Enterprise
 , , and  .Repository Workgroup Repository Personal Repository

Repository Administration tool

A tool used to manage Personal and Workgroup Repositories. With the Repository Administration tool, you can compare versions, copy the
contents from one repository to another, and manage data migration between separate repositories.

reuse

The practice of using existing objects when possible, rather than creating new ones. See also .code reuse analysis (CRA)

reverse engineering

A process in the  that converts a database diagram's relational objects (tables, keys, and columns) back to the ERD'sDatabase Diagram tool
logical objects (entities, relationships, attributes, and identifiers).

reverse trace analysis

Tracks and reports how the relational objects in the database model correspond to the logical objects in an .Entity Relationship Diagram (ERD)

rollback

Abandons any changes you made in a workbench since the startup or the last  or rollback.commit

root process

The process immediately beneath a function in an AppBuilder application hierarchy. In an AppBuilder application,  refine into  .functions processes

root object

An object in the hierarchy that has no parent. Also called an orphan object.

root rule

A  defines a leaf process. A root rule has no input or output views and is the rule that a process invokes. See also  .rule drawing tools

rule

An object type in the  that defines the logic of a process, controls the execution of other rules and components, conversesInformation Model
windows and reports, and accesses files. In contrast, a component generally performs only a special system task.  statementsRules Language
specify the processing logic. See  and .mainframe rule workstation rule
Also, see  and  and  and .frontier rule remote rule root rule subrule

Rule Painter



A  tool for writing  source code. Rule Painter is an intelligent editor that helps you write rules quickly andConstruction Workbench Rules Language
correctly by prompting you with names of fields, views, and other objects in your application's rules hierarchy.

Rules Language

The pseudocode for coding the logic for AppBuilder applications. The syntax and semantics are similar to but simpler than other high-level,
block-structured programming languages, such as COBOL and C. Rules Language constructs are translated into any supported target language.

RuleView

A source level debugger available on both the mainframe and workstation that enables you to directly debug  code. RuleView letsRules Language
you step through rules code line by line, trace through rules, and set  to interrupt execution. Data is presented in a view, and you canbreakpoints
collapse, expand, or modify the data in any view that the rule you are currently executing can access.

S

SBCS

See  .single-byte character set (SBCS)

scope

Controls the possible connections when you navigate between objects. A number of object types comprise a scope, so that only those object
types are considered. Scopes are used to control downloading, uploading, and repository reports.

scroll box

A small box in a window's scroll bar that shows the position of the visible information relative to the total amount of available information. Users
move the scroll box with a mouse to scroll through the information.

section

An entity type in the  that, in conjunction with a report entity type, defines the paper output an application (usually a batchInformation Model
application) produces for end users. Each section defines a particular part of a report (such as a header section and footer section). You typically
create a report and its associated sections using the . A property of the Contains relationship determines which part of the reportReport Writer
each section defines.

Security Information Model

Defines the object types (users, groups, products, etc.) and relationships between them in the  . This is a subset of the security system Information
.Model

security system

Controls access to production systems in the runtime environment.

seed

The connection between a Migration entity or a Rebuild Package entity to an application.

server

A unit that provides shared services to client workstations over a network.

service

Code that performs some task, such as accessing a database, for a  program.client

service agent

See  .agent

session

1. A user's connection to the repository, particularly used to describe connections to a  . Sessions are usually automaticallyWorkgroup Repository
opened and closed by a workbench.
2. Current working time between starting and stopping the Construction Workbench, or between the times you  to the  changescommit repository
made to the application.



set

An object type in the  that represents a group of symbols and the corresponding values. (An older style of set, still supported,Information Model
used hard-coded values rather than symbols.) See also  .symbol

sibling

A child object that shares a parent with another such object. That is, the two objects reside at the same level in a hierarchy.

single-byte character set (SBCS)

The standard ASCII or EBCDIC character sets in which a different one-byte code represents each of 256 possible characters. See also 
 .double-byte character set (DBCS)

smallint

A "small integer", a data type that denotes a two-byte integer between -32,767 and +32,767. Contrast with .long int

smart scope

An extension to basic scope that provides additional navigational information so you can specify navigational closure. For example, when
navigating through the components associated with a rule, rather than all components associated with the rule, smart scope lets you navigate
through only those components not provided in the default repository. See also  .scope

SQLJ

IBM, Informix, Oracle, Sun Microsystems, Sybase, Tandem, and others have contributed to this standard for embedding static SQL statements
and constructs in Java programs (ANSI X3.135.10-1998). This reduces development and maintenance costs of Java programs that require
database connectivity by providing a mechanism to use SQL statements directly.

stand-alone application

An application that is fully developed and run on one machine, independent of any other system.

state

An entity type in the  that is a discrete set of attributes, values, and relationships a data object holds at a point in time. A logicalInformation Model
stage in the life of a  , a state has duration, occupies an interval of time, and is often associated with a continuous activity (such asdata object
invoice collection). An  separates two states, and a state separates two events.event

State Transition Diagram

A network diagram of states and events; it shows changes in the behavior of a data object. A State Transition Diagram is a model that identifies
the stages (or states) a data object goes through in its life, and the external and internal business events that trigger a set of processes and cause
the data object to move from one state to another. A State Transition Diagram constitutes a data object's control view, because it captures
business rules that translate into system controls. A State Transition Diagram is also called a state transition model.

State Transition Diagram tool

A  tool for producing  .Construction Workbench State Transition Diagram

static linkage

Passes control directly from one object to another without the intervention of the runtime system. All the reports, rules, and components of a
statically linked application are bound together at link-edit time and loaded together as one module at runtime. See also  .dynamic linkage

static text

A  object with a data link that appears on an end-user window as descriptive text-that is, a label.Window Painter

structural model

Data structures composed of AppBuilder structural objects (files, views, and fields) that an AppBuilder  uses to read from and write torule
database tables. You can translate a relational model to a structural model with the  's transformation process. See also Database Diagram tool

 ,  ,  , and  .field file transformation view

Structured Query Language (SQL)

A language used to access relational database management systems.



subrule

The child of a parent rule or a rule that is called from another rule. This is an AppBuilder short-hand way of describing a rule that is called by
another rule. In some contexts, it is referred to as the  as opposed to the  .called rule calling rule

subscript

The occurring view's argument that specifies a unique occurrence.

Super Prepare

Prepares an object and all of its children.

supertype-subtype hierarchy

Indicates an entity type that shares many of the same attributes as another entity type. Supertypes and subtypes hierarchically structure related
data. The supertype has a unique  and common attributes that all of its subtypes inherit. Each subtype has special characteristics thatidentifier
further classify it as a child to the supertype and differentiate it from other subtypes. Thus, a supertype entity type is a parent entity to its children
subtypes.
For example:  is a supertype classified into  and  subtypes.Customer Retail Customer Institutional Customer

symbol

An entity type in the  that represents the name of a particular value within a  .Information Model set

symbolic value

See  .value

system component

These are AppBuilder supplied components (small programs) that can be used to achieve things that Rules cannot. Developers can also writer
their own components called User Components. Also refer to .user component

system ID

A property of an AppBuilder object that uniquely identifies it in the repository. A system ID is automatically generated when you create the object
and is required because a short, unique name is required to identify objects within the repository. (When created on the mainframe, it has 6, 7, or
8 characters; on the workstation it has 7 characters.)

T

table

A logical data structure in a relational database system. One of the three objects in a relational model, a table is a logical grouping of data into
rows and columns, and often implements an entity. See also  ,  , and  .column key relational model

TCP/IP

An inter-machine communications  supported by IBM OS/2, Microsoft Windows, and the various versions of the UNIX operating system.protocol

thick client

The self-contained part of an application that runs on a client machine without the help of the part running on a server. See also  .thin client

thin client

The part of an application that runs in a Web browser with information from a servlet or other services running on a server. See also  .thick client

TP monitor

Software that controls transaction processing across a network.

trace analysis

Tracks how the  corresponds to the relational database model so you can assess the impact of changing the logicallogical data model (LDM)
model. You do a trace analysis from the  in the  . Trace analysis generates a report thatEntity Relationship Diagram tool Construction Workbench



shows how logical objects in an entity relationship diagram (ERD) are converted to relational tables. See also  , Entity Relationship Diagram tool
 ,  , and  .logical data model (LDM) relational model table

traceability

Additional information stored with  objects that enable trace analysis to track how logical objects are translated to relationalInformation Model
objects and vice versa. See also  and  .reverse trace analysis trace analysis

Transaction ID page (TIP)

Records in a  the identity and statues of currently active connections for data integrity and recovery.Workgroup Repository

transformation

An engineering process available in the  of the  that transforms a relational model's objectsDatabase Diagram tool Construction Workbench
(tables, columns, and keys) to an AppBuilder structural model (files, view, and fields).

transition

An entity type in the  that represents an event and the processes it triggers to cause an entity to change states. In a Information Model State
 , a transition is a relationship that shows how a data object can move from one state to another state. A line between twoTransition Diagram

states represents the business event that causes the transition. See also  ,  ,  ,  , and  .data object event relationship state State Transition Diagram

U-V

Unit of Work (UOW)

Unit of Work is a group of only your changed objects. Using a UOW simplifies the upload, download, and migration processes. See logical unit of
.work (LUW)

upload

The process of copying an object from the  on the workstation to the  on the mainframe. See also Personal Repository Enterprise Repository
 .download

user component

User Component is a user written program that achieves something that AppBuilder system components and Rules cannot. See also .component

value

An object type in the  that represents any constant.Information Model

version

An object in the repository that represents a set of individual objects. A version object acts as a view of the repository. It sees and manages a set
of objects, their relationships, and object revisions. A version sees specific revisions of objects and relationships.

version states

The stages of a version. There are four allowable states: Working, Text, Frozen, and Released. The state of a version can be changed to reflect
its use.

view

An object type in the  that defines data structures in AppBuilder applications. A view is a group of properties that furtherInformation Model
describes and characterizes an object. Views define input and output data structures of a rule, a component, a window, a file, and a section.
Views include other views and fields, which can create very sophisticated data structures.

W-X-Y-Z

window

An object type in the  that defines the interactive user interface to an application. You paint objects on windows to let end usersInformation Model
view data in different formats, modify data, or control application execution. These objects include check boxes, combo boxes, edit fields, list
boxes, multicolumn list boxes, push buttons, radio buttons, menus, and static text.



Window Flow Diagram tool

A  tool that lets you model window flow and user interaction during the prototyping phase.Construction Workbench

Window Painter

A  tool for designing and developing an application's end-user interface. Using window, view, and field objects defined inConstruction Workbench
the  as input, Window Painter enables you to control the size, shape, and colors of window, determine the layout of the fields, definerepository
push buttons and menu selections, and so forth. You determine what the end user can see and do in each window.

window view

A view linked to a window object instance.

work view

A property of the   relationship that defines a view as a temporary local storage area visible only to the owning rule. A owns relationship type rule
can read from or write to its own work view but cannot see any other rule's work view. Only a rule can own a work view.

Workgroup Repository

An AppBuilder  that developers access through a network. Their work is concurrent and other developers within their group can accessrepository
it without importing or exporting the data. (See also .)Workgroup Repository

workstation

An object type in the  , an instance of which represents an individual workstation. Each workstation can be a memberSecurity Information Model
of a single  .workstation group

workstation group

An object type in the  that represents a logical collection of  s. Security restrictions are applied toSecurity Information Model workstation
workstation groups.

workstation rule

Any  that executes on the  . Workstation rules are not platform specific and can use mainframe rules. Examples of workstationrule workstation
tasks that workstation rules execute include drawing windows and displaying data. (A rule that IS platform specific is a .)mainframe rule

XML

Extensible markup language. Used in parts of AppBuilder.
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